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インストール                
Topaz DeNoiseはそれ自体では使用できず、Photoshopなどの互換性のあるホストプログラムを必要と

するプラグインです。 

 

インストール方法  

1. Photoshopやその他画像編集アプリケーションを起動中の場合は、それらをすべて終了してください。 

2. インストール CD、又はダウンロードしたファイルの Topaz DeNoise zipファイルを開きインストーラ

をダブルクリックしてください。インストールウィンドウが開いたら指示に従いインストールを進めてく

ださい。 

 

 

 

 

 

 

 

 

3. PhotoshopがインストールされていればTopazのプラグインファイルがPhotoshopの“plug-ins” という

フォルダ内に自動的にインストールされます。 

4. インストールの後、ライセンスキーもしくはトライアルキーを入力して下さい。 

 

キー入力  

1. Photoshopにて画像を開きます。 

2. Filters -> Topaz Labs -> DeNoise -> Menu -> Enter keyへと進みます。 

3. それからコピー&ペースト、あるいはキーを入力します。 

 

ホスト別インストール  

Topaz Adjust は Photoshop プラグインをサポートするほとんどのホストアプリケーションで動作しま

す。これらのホストアプリケーションには、主に Paint Shop Pro、 Painter、 Irfanviewなどがあります。 

 

Topaz DeNoiseのインストール方法はホストプログラムによって異なります。 

Paint Shop Proや Photo Impact、 Irfanview に Topaz DeNosieをインストールするには、まず既定の場

所に Topaz DeNoiseをダウンロードして下さい。そして、各ホストが指示する方法にしたがってインスト

ールを進めてください。以降よりこれらのインストール方法を示します。 
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Irfanviewへのインストール方法   

 
１． Irfanview ウェブページ (http://www.irfanview.com：英語)にて入手可能な Plugins/Addonsをインスト

ール済みであることを確認してください。 

 

 
 

２．Irfanviewを開き、 Image -> Effects -> Adobe 8BF filtersに進んで下さい。 
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３．ポップアップスクリーンで “Add 8BF filters”を選択し the C:¥Program Files¥Topaz Labs¥Topaz 

DeNoise¥Pluginsフォルダを選択して“OK”をクリックして下さい。 Available/Loadable 8BF Filters 

セクションに“Topaz DeNoise 3”が表示されるようになります。 

 

 
 

４．Topaz DeNoiseを使用する時には、Image -> Effects> Adobe 8BF filtersと進み、“Topaz DeNoise 3”

を選択してください。 
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Paintshop Pro / Photo Impactへのインストール方法  

 

1. まず PaintShop Pro / Photo Impactを起動して下さい。 

2. “File Types” リストの中で“Plug-ins” を選択し Menu file -> Preferences -> File Locationsから“Add”

をクリックして下さい。 

 

 

 

 

 

 

 

 

 

 

3. C:¥Program Files¥Topaz Labs¥Topaz DeNoise plug-ins を選択し、“OK”をクリックして下さい。 
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4. Topaz DeNoise が使用できます。Effects -> Plugins へ進み “Topaz DeNoise 3”.を選択して下さい。 
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製品紹介  
 

Noise 
Noise(ノイズ )とは何ですか? 

Noise(ノイズ)とはデジタルカメラのセンサによって起こる予測できない様々な言わば「汚れ」のことで

す。 多くの場合、ノイズは画像にざらつきやドットのようなものが現れます。また、ノイズは明度や、

あるいは色彩にムラがあるように現れます。 

  

多くの場合、ノイズは影の濃い部分や、露光不足の部分に表示されます。これは. 照明の量が少ないと、

多い時よりも視覚情報が少ないので、ノイズが表示されやすくなる傾向があるからです。 

 

何が原因でノイズになるのですか? 

ノイズは多くの事柄が原因となって起こります。それらは、撮影時のざらつき、感光性のセンサ、ある

いは高い ISO値で撮影した時などに起こりやすいです。  

 

ノイズの結果  

ノイズが現れると画像の細部や明瞭さに影響し視覚的にきれいな画像とはなりません。 
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Topaz DeNoise  
 
Topaz DeNoiseについて  

Topaz DeNoise は最良のノイズ除去ができる画期的な画像処理技術を用いた Photoshopプラグインで

す。  

 

Topaz DeNoise は最新のアルゴリズムを用いて設定の微調整や調整用レイヤの作成に時間をかけず効

率的な画像補正を提供します。さらに、いくつかのサンプルレイヤを適用した補正画像が確認できるプリ

セット機能が用意されているため、それらを基準として微調整をすることで効率的な画像補正が可能とな

ります。 

 

Topaz DeNoise では画像の細部を保持しつつノイズを削減するほかに類を見ない画像処理によって明

瞭な写真を表現することができます。 

 

 

 

 

 

 

 

 

 

Topaz DeNoise3.0適用前 

 

 

 

 

 

 

 

 

 

 

Topaz DeNoise3.0適用後 

Topaz DeNoise の主な機能を以下に示します。 
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1. ノイズを軽減するために最良の品質を実現します。多くのノイズを除去し可能な限りにおいて細部を

表現します。  

2. 露光調整を明るくすると同時に過度のノイズを除去するとこで露光不足を改善する役目を果たします。 

3. ノイズが原因で不鮮明だった画像が完全に明るく復元されます。 

4. 何度も入力せずに除去するノイズを効果的に、また自動的に検出することで簡単に、迅速に、何度も

ノイズ除去を行なうことができます。  

 

DeNoiseの新機能  

Topaz DeNoise 3.0バージョンは独創的に広範囲のノイズ削減を行なう能力があり、処理時間を迅速に、

そして細部の保持に優れ、滑らかに、様々な能力に磨きをかける特徴があります。さらに、細部の表現、

復元、多数のカラーノイズの様子も可能とします。これらの機能を使用することで、修正したいと思うノ

イズの詳細な情報に注目することができます。  
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作業領域  
 

インターフェース  
Topaz DeNoise の操作ウィンドウを見ると一見難しそうに見えますが、そのようなことはありません。

多様な機能を理解しやすいように下図のように５つのセクションに分けて説明します。 

 

 

 

 

 

 

                                      

                                         

          

          

           

 

 

 

 

                                                                    

 

 

 

 

 

 

 

 

 

 

 

1.プレビュー 

編集中のプレビュー

画像を表示します 

 
2.プリセット 

あらかじめ設定さ

れたパラメータを

適用できます。 

3.メニュー 

ユーザ設定を有効にし

たり、その他のオプショ

ンを設定します 

 

4.設定とパラメータ 

さまざまな効果を調整するためのつまみを調節します。 

 

5.プレビューナビゲーター 

現在見ているプレビュー画像の範囲を表

示します。 
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プレビューセクション  
プレビューセクションとは編集中の画像表示部分のことで、右上の大きな画面を示します。スクロール

するには画像上で左クリックして画像をつかみ、そのままマウスを上下左右に移動します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

元の画像を確認するには “View Original Image”ボタンを押してください。離すと編集中の画像に戻

ります。また、スペースキー押下で同様の操作ができます。 
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プレビュー画像の下の“+”、あるいは“-”ボタンをクリックしプレビュー画像を拡大・縮小でき、ウイン

ドウの大きさも調節できます。“Fit”ボタンは全体画像を画面にフィットさせます。100%未満における画

像サイズ変更では、プレビュー更新速度を速めるために内部的にサイズ変更が行われます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

Photoshop と同じく、“Ctrl +” と “Ctrl –”により画像の拡大・縮小が可能です。矢印キーにより現在

選択されているスライダーの調節が可能です。ショートカットキーの全リストはこのマニュアルの後半

に記載されています。Photoshopおよびその他ホストソフトウェアはグレースケール、 RGB、LAB、

CMYKなどを含む多くの画像モードをサポートします。画像はチャンネルごとに、8, 16, あるいは 32 ビ

ットの画像を処理することができます。Topaz DeNoiseはチャンネルごとに 8、16ビットの両方をサポ
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ートします。Topaz DeNoiseは RGBモードのみサポートします。モノクロ写真においては最初に RGB

モードに変換します。 

 

プリセット  
プリセットは Topaz DeNoiseの全プロセスを簡略化、高速化するためのすばらしい機能です。 プリセ

ットは既存の設定で行なわれたプレビュー画像です。 

 

Topaz DeNoiseにはいくつかのプリセットがデフォルトで用意されています。これらは個々の写真に適

用されるわけではありませんが、本フィルタを使用して画像処理を施す際に基準となるフィルタとして利

用することができます。 

 

プリセットの適用方法  

プリセットの適用方法は、ただ好みのプリセットをクリックするだけです。プリセットをクリックする

と、すべてのパラメータが自動的に設定されます。その後自分なりにパラメータを微調整してください。 

 

個々のプレビューの代わりにリストモードでプリセットを見たい場合、Previewメニューをクリックし

て“Toggle list/Thumbnail”を選択してください。このモード切替えには数秒かかることがあります。リスト

ビューを使用することで Topaz DeNoiseの起動動作を高速化できます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

プリセットプレビューの表示更新  

メインプレビュー画面を拡大・縮小、表示移動してから、プリセットのサムネイル画像にそのメインと

同じ部分を表示したい場合は、 Refresh ボタンをクリックしてください。その後すべてのプリセットに
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反映されます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

プリセットメニュー  

Topaz DeNoiseには複数の多様なパラメータがあるため、後で使用するための設定を保存するプリセッ

ト機能は非常に便利な機能です。設定を保存するためには、Presets メニューから“Save…”ボタンをクリ

ックしてください。 

 

  

 

        

 

 

 

 

 

 

プリセット名と任意の記述を入力し OK をクリックして下さい。入力した名前がすでに存在する場合、

既存のプリセットを上書きしますのでご注意下さい。 

 

保存したプリセットは”プリセット名.tpp”で新規ファイルとして保存されます。 
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新規プリセットは Topaz DeNoiseのプリセットメニューに追加され、プレビューが自動的に生成されます。

後でそのプリセットを使用したければ、メニューから生成されたプリセットを他と同様にクリックしてく

ださい。 

 

プリセットの削除  

プリセットを削除したければ、“Delete…”をクリックしてください。 

 

すでに提供されているデフォルトプリセットを上書・削除することはできません。 

プリセットの共有  

保存したプリセットファイルを Topaz DeNoise をインストールしている他のユーザに e メールで転送

し、そのファイルを Presetsフォルダにダウンロードすることで共有することも可能です。 

 

保存したプリセットは Topaz DeNoise をインストールした C:¥Program Files¥Topaz Labs¥Topaz 

DeNoise 3¥Presets内の“Presets”フォルダ内にあります。それ以外のフォルダにインストールした場合は

上記フォルダ以外に保存されます。Presets フォルダ内にはすでにいくつかのプリセットファイルが存在

しています。 

 
Macをご使用されている方は HD/Library/ApplicationSupport/TopazLabs/DeNoise3/Presets内にいくつ

かのプリセットファイルが存在しています。 
 

プリセットのインポート /エクスポート  

プリセットファイルをインポートするには、Import (インポート)ボタンをクリックして下さい。 

 

 

 

 

 

 

 

 

ブラウズボックスが出現し、あなたのコンピュータに保存されている Topaz DeNoiseプリセットが表示

されます。これは使用したいプリセットファイルをダウンロードするときに便利です。 
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インターネットから直接プリセットファイルをインポートするには、Import from Internet…ボタンを

クリックし、プリセットファイルのあるフォルダ内にそれらをダウンロードしてください。 

 

 

 

 

 

 

 

 

 

 

プリセットファイルを特定の場所にエクスポートするには、“Export”をクリックしてください。その後、

このファイルをインポートした他のユーザと共有できるようになります。 
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また、現在の設定を eメールやフォーラムに自動的に添付することができます。これは設定を共有した

いけれど保存やプリセットのエクスポートが面倒なときに便利です。 

詳細については 15ページを参照ください。 

 

スナップショット  

Topaz DeNoise v3.0には“Snapshots”という新しい機能があります。 

これはプリセットパネルの右下にあります。 

 

 

 

スナップショット機能は作成した画像をプリセットとして保存することなく２つまでのセッティング

を比較することを可能とします。たとえば、ある画像において２つの異なる設定がどう作用するかを確認

したい場合、その両方をプリセットに保存、適用、削除することなくスナップショットに保持するだけで

簡単に比較することができます。 

 

現在の設定をメモリに保持するためにスナップショットを使用するには、単純に Snap 1 もしくは

Snap 2をクリックしてください。Recall 1 もしくは Recall 2をクリックすることでプリセットの操作と

同じように Snap 1 もしくは Snap 2の設定をプレビュー画像に適用することが出来ます。ただし、Topaz 

DeNoise で使用しているスナップショットは Topaz DeNoise 起動中のみ使用可能であるので Topaz 

DeNoise終了時、これらのスナップショットはすべて削除されることにご注意ください。 
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ナビゲータ  

現在、ご覧になっている画像範囲をプレビューナビゲータで見ることができます。また、ナビゲータの

赤枠の中の画像をつかんで移動することで、プレビュー画像をスクロールすることができます。 
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メニューと設定  
 

Menu (メニュー) 
フィルタウインドウの右下にある Menuボタンより Topaz DeNoise のメニューにアクセスできます。 

 

 

 

 

 

 

 

 

 

 

Preferences  
Topaz DeNoiseウインドウの pop-up helpやプレビューのパン速度（プレビューをつかんで移動させる

速度）の設定を変更できます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

Enable popup helpはマウスがフィルタエリアでホバリングした時に表示するツールチップ(ふきだし

による説明)を有効にします。もし作業の妨げとなるようでしたらオフにして下さい。 

Pan preview faster は Topaz DeNoiseプレビューのパン速度（プレビューをつかんで移動させる速度）
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に影響します。 

 

注) “Disable multi-processor support” オプションは Macをご使用の方のみ有効です。 

 

Check for Updates 
ボタンによりユーザのコンピュータにインストールされている Topaz DeNoise のバージョンをチェッ

クでき、最新バージョンが入手可能であればお知らせいたします。  

. 

 

 

 

 

 

 

 

 

Enter Key 
ライセンスキーもしくはトライアルキーを入力します。 

 

 

 

 

 

 

 

 

 

 

 

User’s Guide 
このユーザーズガイドを開きます。 

Technical Support  
技術的なサポートページへご案内いたします。 

Online Resources 
ビデオチュートリアル（使用例）や現在あなたが表示している画像に対する提案が得られる Topaz 

DeNoiseのホームページにリンクします。 
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About 

Topaz DeNoiseのバージョン情報およびホームページアドレスを表示します。 

Share / Copy Settings to Clip Board 

Shareボタンは現在の設定を eメールやフォーラムに自動的に添付する機能です。これは設定を共有し

たいけれど保存やプリセットのエクスポートが面倒なときに便利です。 
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設定とパラメータ  
 

 Topaz DeNoiseには最適な画像を得るために２つの設定タブと合計 9個のパラメータが存在します。 

 

Main (メイン) 
“Main”タブには“Suppress Noise（ノイズ抑制）”、“Recover Details（細部復元）”、“Clean（整理）”、

“Reduce Blur（不明瞭さの削減）”といった４つのパラメータがあります。 

 

 

 

 

 

 

 

 

 

Suppress Noise （ノイズ抑制）  

これはこのフィルタの中のメインパラメータとなります。1 の値は Topaz DeNoiset が自動的にノイズ

の分布を検出し、画像に正確に計算したノイズ量を除去します。1以下の低い値は少量のノイズを除去し

ます。1以上の値はさらに多くのノイズ(ノイズマップに比例して)を除去します。  

  

Recover Details （細部復元）  

このパラメータは画像の細部を復元します。最適な使用方法は、まずパラメータ”0”の値にし、それから

Suppress Noise(ノイズ抑制)を適用します。その結果、細部をより鮮明に復元します。 

. 

Clean（整理）  

このパラメータは画像を滑らかにします。しかし、値を高くしすぎますと細部がぼやける場合もありま

す。 

 

Reduce Blur （不明瞭さの削減）  

このパラメータはノイズを除去した後、ぼやけた、あるいはつなぎをぼかした画像を修正するのに便利

な、優れた機能です。只、エッジがぼやけ、ノイズが増幅する傾向がありますので必要以上に値を上げな

いでください。 

Suppress Noise(ノイズ抑制)は必要とされる機能です。DeNoise 3.0にはプログラムを起動した時、瞬時
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に最適なパラメータを設定する自動検出機能があります。  

  

アドバンス機能を使用したいときには、Advanced タブで調整することができます。 

 

Advanced 
Advance タブには”Clean Color(カラー調整), “Remove Color Specks(カラー粒子の除去 )”, “Adds 

Grain(ざらつきを追加)”,”Recover Re(不明瞭さの削減)”や “Recover Blue(赤い部分の復元)”といった 5 つ

のパラメータがあります。 

 

 

 

 

 

 

 

 

Clean Color (カラー整理 ) 

カラー量に関する制御を行ないます。値を上げますとカラーのムラを修正します。 

 

Remove Color Specks (カラー粒子の除去 ) 

カラーアーティファクト(カラーのムラ)を除去します。 

 

Add Grain(ざらつきを追加 ) 

画像をより自然に加工するためにモノクロのざらつきを追加します。 

 

Reduce Blur （不明瞭さの削減）  

カラーの不明瞭な細部を復元します。 

 

Recover Red(赤い部分の復元 ) 

赤の部分を復元します。 

 

カラー表示モード  
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Normal (標準 ) 

通常の画像を表示します。 

 

Luma (ルーマ ) 

画像の明度を表示します。(白黒もしくは無色の部分) 

 

Color (カラー ) 

カラー構成要素を表示します。 

 

Blue (不明瞭さ ) 

カラー構成要素を識別します。 

 

Red (赤色 ) 

赤の部分の構成要素を識別します。 

 

パラメータのリセット  
“Reset”ボタンでいつでもパラメータをリセットし既定の設定に戻すことができます。 
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操作の流れ  
 

サンプルプロジェクト  
本セクションでは DeNoiseをより熟知していただくために実際の操作例を示します。 

 

 

 

 

 

 

 

 

 

 

 

 

           DeNoise適用前          DeNoise適用後  

 

上記のサンプル写真をご覧下さい。 

DeNoiseを使用する前と後とでは、ノイズが軽減され、細部が鮮明に修正されているのがお分かりかと思

います。このような最適な写真をどのような手順で行なわれたかを順を追って説明していきます。 

 

1. 画像ファイルを開きます。カメラに搭載されている RAW データのデフォルトノイズ軽減機能や輪郭

を強調したり、逆に弱めたりといった画像処理をすることはできません。ですから Topaz DeNoiseで

調整することはできません。 

 

2. 2つの画像レイヤを作成します。画像レイヤ上で右クリックし 2つのうちの 1つを選択します。また、

画像を選択し新規のレイヤアイコンにドラッグすることも可能です。 
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ノイズ軽減を瞬時に行なう方法は、まず DeNoise を開くと自動的に変更が行なわれます。そして OK

を選択すると画像が準備のできた状態になっています。 

  

3. 画像処理を行なうには Filters ->Topaz Labs ->Topaz DeNoise 3へと進んでください。 

 

4. プレビュー画像上でクリックし、ドラッグします。もし画面上で瞬時に画像を移動したい場合、

“Preferences ...” を選択し “Pan preview faster” にチェックを入れます。 
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5. もし右側ウィンドウのパネルで既定のプリセットやスクロールを選択したい場合、選択しクリックす

るとスライダーが自動的にあらかじめ設定したパラメータに適合します。 

 

6. 通常は “Normal”カラーモードにします。 “Luma” カラーモードに切り換えることも可能です。 

 

 

 

これはカラーアーティファクトのない画像を可能とするモノクロカラーモードです。  

 

 

 

 

 

 

 

 

 

 

 

 

 

このモードから始め、その後カラーモードを選択することで補正効果を確認することができます。このよ

うに多くの写真はこれらの 2つのカラーモードを使用して画像を補正することができます。 

 

7. Main タブにある “Suppress Noise” へ進んでください。 

 

 

 

 

 

 

 

 

 

大量のノイズを軽減するときにはこのパラメータを使用します。通常レベル 1で設定します。低い値は

ノイズの軽減率は低いですが、高い値にすると画像の細部までノイズを軽減することができます。です
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から、画像のノイズを除去すると同時に細部に渡り補正を可能にするため最も低い値にスライダーをド

ラッグするはずです。 

 

8. “Suppress Noise”を使用後, 写真のエッジの一部がぼやけているのが分かります。これは“Reduce 

Blur” (不明瞭さの削減)スライダーで補正されるノイズ削減の効果です。スライダーを上げていくと不

鮮明な画像を補正しますが、ただスライダーを上げすぎるとエッジがぼやけ、ノイズが増幅する傾向

があります。“Reduce Blur”のパラメータの値が 0.25～0.50 でスタートすると良いでしょう。細部を

鮮明にしたい範囲までスライダーを移動します。 

 

9. 不鮮明な画像を補正後、エッジが鋭すぎた場合、“Clean”スライダーを使用してそれらを柔らかくする

ことができます。  

 

10. もし画像の細部が損失した場合、“Recover Detail”を使用して復元が可能です。タブは高い値にすると

ノイズ量が再び増加しますので徐々に上げていきます。これらのパラメータを使用することでノイズ

を軽減すると同時に細部を保存する最適なバランスをとることができます。多くの写真では、これら

の 4つのステップで希望の画像に補正するのに十分かと思われます。 

その場合、OKボタンを押すだけでできます。しかし、さらに補正をしたい場合、”Advancedタブ”が

必要とされるかもしれません。引き続き、説明していきます。 

 

最高の仕上がりとなる画像を入手する最善の方法はこれらの効果を説明文から理解することは難しい

かもしれませんが、実際に操作して視覚的に実感することにより効率的な学習が可能となります。 

 

 

 

 

 

 

 

 

 

 

 

 

11. 滑らかなカラーに設定しましょう。もし画像になかったムラなどがある画像を補正するときには、

“Color” プレビューモードを選択してください。 
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“Advanced”タブにある“Clean Color”スライダーを選択しパラメータの値を上げてください。 

もし画像の一部に色の彩度が減少したら、この値を下げます。もし色ムラがまだ残っているようでし

たら、“Remove Clr Specks”を使用して色ムラを除去します。 

 

12. もし細部のカラーを復元したい場合、“Blue”(不明瞭さ )カラーモードに切り換え、“Recover Blue”(不

明瞭さを復元)のスライダーを使用して細部を復元します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ざらつきのある画像になるまで上げてください。 

赤い色を同様に補正するときは“Red”(赤色)カラーモードに切り換え“Recover Red” (赤色復元)スライダ

ーを使用して細部を復元します。  
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13. 最後に、画像を自然な仕上がりにするために “Add Grain” スライダーを使用していくつかのムラを追

加してください。 

デフォルトの値は 0.05で設定されています。 

 

ビデオチュートリアル（実演による説明）や情報などが Topaz DeNoise のホームページ

http://www.topazlabs.com/denoise（英語）に掲載されています。 

 

14. “Normal” (標準) モードに切り換えて、最終調整を行なってください。 
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お好みの設定ができ、“OK” ボタンを押したら Topaz DeNoiseが画像処理を行ないます。 

 

 

 

 

 

 

 

 

 

 

これでノイズの無い画像が完成です。 
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よくある質問  
 

 

“Photoshopのフィルタメニューに Topaz DeNoiseが見当たりません。”  

Windowsご使用の方： 

１． C:¥Program Files¥Topaz Labs¥Topaz DeNoise 3¥Plugins内の tlDeNoise3.8bfファイルをコピーして

ください。 

２． 通常 C:¥Program Files¥Adobe¥Adobe Photoshop CSx¥Plug-Ins に位置する Photoshopの Plug-Ins

フォルダ内の Topaz DeNoiseに関連する全ファイルを削除してください。Topaz DeNoiseや

tldenoise3.8bfというファイル名が付けられているはずです。その後先ほどコピーした tldenoise3.8bf

を貼り付けてください。 

３． Photoshopを終了し、再起動してください。Topaz DeNoiseがフィルタメニュー内に表示されるはず

です。Topaz DeNoiseを使用するには事前に画像を開いている必要があります。 

 

Macご使用の方： 

１． /Library/Application Support/Topaz Labs/ DeNoise 3/Pluginsフォルダ内の Topaz_denoise3.pluginフ

ァイルをコピーしてください。 

２． Applications/Adobe Photoshop CSx/Plug-Ins (もしくは Photoshop Plug-Ins フォルダがある場所)。 

Topaz DeNoiseに関連するファイルすべてを削除してください。その後、右クリックより先ほどコピ

ーした Topaz_denoise3.pluginファイルを Photoshop Plug-Insフォルダ内に貼り付けてください。 

３． Photoshop を再起動し、Topaz DeNoiseがフィルタメニュー内にあることを確認してください。

Topaz DeNoiseを使用するには画像を開かなければなりません。 

 

“プリセットが見れません。”  

おそらくお使いのプリセットファイルが読み込み不可となっているからです。Mac においては、

“/Library/Application Support/Topaz Labs/ DeNoise 3”をチェックし、Presetsフォルダにて右クリック

してください。すべてのユーザに対して少なくとも読み込み可能となっているかどうかを確認してくださ

い。プリセットを保存したい場合は、書き込み可能にする必要があります。 

また、規定のフォルダにインストールされていない場合は、プリセットは表示も保存もできません。 

 

 “どこにキーを入力すればよいですか？”  

 キー入力のため、まず Photoshopにて画像を開きます。Filters -> Topaz Labs -> DeJPEG3 -> Menu... -> 

Enter key...と進み入力画面が表示されます。 

 



ご不明な点がありましたら http://www.nixus.jp よりお問い合わせください。 
35/35 

用語集  
 

アルゴリズム‐問題を解くための効率的手順を定式化した形で表現したもの。 

チェッカーボーディング‐チェッカーボードのような大きな画素ブロックの形をした歪み。通常は圧縮

率の高い画像に生じ、特に情報量の多い領域に見られる傾向があります。 

カラーチャネル‐主要な色の組み合わせで多彩な色を表現するデジタルカラー画像のカラー要素。典型

的なデジタル画像では Red（赤）、Blue（青）、Green（緑）をカラーチャネルとする RGB カラーモデル

が使用されます。 

カラーノイズ‐不鮮明なエッジに見られるデジタルノイズ、または画像の色ムラや不自然な点の集合。 

圧縮アーティファクト‐不可逆圧縮による画像や映像に見られる歪み。 

ダウンロード‐あるデバイスから他の端末へのデータ転送プロセス。 

エッジアーティファクト‐画像内のエッジに見られるアーティファクトや歪み。 

エクスポート‐転送しようとしているデータを他のプログラムが使用可能な形式に変換すること。 

画像圧縮‐画像データの圧縮。不可逆圧縮、特にデータ量の少ないものは圧縮によりデータが失われ、

より多くのアーティファクトを発生させます。最も広く使用されている画像圧縮形式は JPEGです。 

インポート‐入手しようとしているデータをファイルやドキュメント形式に変換すること。 

可逆圧縮‐本質を保ちつつデータサイズを削減する再生可能な圧縮方法です。 

不可逆圧縮‐データを近似することでサイズを削減する再生不能な圧縮方法です。 

ノイズ‐デジタルカメラにより撮影された画像に生じる干渉をいい、画像にランダムな色合いにちりばめ

られた点や、均一な色が続く領域に見られるムラとして確認されます。たいていは暗い部分や影になって

いる部分に発生します。ノイズは全体的な画質を損なう望ましくない効果であるか、もしくは芸術的な効

果として使用される場合もあります。 

パン‐カーソルをプレビューの上でクリックしてそのままドラッグすることでプレビュー画面を自由に

移動させる機能。 

パラメータ‐目的となる結果に変化を与えるいくつかの変数のうちの一つ。 

プラグイン‐システムの向上のために追加できるモジュールやソフトウェア。 

プリセット‐製品にあらかじめ備えられているパラメータと設定。Topaz 製品にはデフォルトプリセッ

トが備えられています。また、プリセットが示す効果を一目で確認できるサムネイル画像が備わっていま

す。 

プレビュー‐編集中の画像表示。プレビューセクションは右上の大きな画面となります。 

スムージング‐表面を滑らかにすること。目に見える突起、こぶ、へこみを平らにします。 

 

CMYK‐プリンターによる印刷において使用されるシアン、マジェンダ、イエロー、ブラックの 4色を使

用したカラーモデルをいいます。 
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Grain‐画像を自然に見せるために使用する軽い斑点の集合のようなノイズ。 

ISO‐デジタルカメラにおけるセンサの感度を示します。ISOが高いほどシャッタースピードは速くなり、

暗いところでの撮影に向いていますが、ノイズが増加しやすくなります。 

Luma‐画像の輝度（色のないモノクロの領域）。Luma は色のない画像を示し、Chroma は色情報を示し

ます。 

RAW画像‐圧縮やノイズ除去などされていない未加工の画像。 

RGB‐Red（赤）、Green（緑）、Blue（青）を基本としてすべての色を表現するカラーモデル。デジタル

カメラやコンピュータのモニタに使用されているモデルです。 
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ショートカットキー  
 

作業効率アップのため Topaz DeNoiseではいくつかのショートカットキー が使用できます。以下のキー

は全工程にて使用可能です。 

動作  Mac Windows 

オリジナル画像の確認 SPACEBAR SPACEBAR 

スナップショット１の呼び出し CMD-1 CTRL-1 

スナップショット２の呼び出し CMD-2 CTRL-2 

スナップショット１の保存 ALT-1 ALT-1 

スナップショット２の保存 ALT-2 ALT-2 

現在作業中のタブのリセット CMD -R CTRL-R 

すべてリセット CMD -ALT-R CTRL-ALT-R 

画像サイズを画面にフィット CMD -0 CTRL-0 

画像の 100%表示 CMD -ALT-0 CTRL-ALT-0 

拡大 + or CMD -+ + or CTRL-+ 

縮小 - or CMD - - - or CTRL- - 

 

Mac ユーザの方： CTRL キーの代わりに CMD を使用してください。 

パラメータのつまみにフォーカスがあれば（たいていはクリックによる）、値変更のため以下のキーが

使用可能です。 

←、↑ 0.01ごと減少 

→、↓ 0.01ごと増加 

Page up 0.1ごと減少 

Page down 0.1ごと増加 

Home 最小に設定 

End 最大に設定 

 

最後にプリセットウインドウにフォーカスがあるとき、プリセットを選択するために↑、↓キーが使用

可能です。 
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製造元  
 

NIXUS（北海道日興通信株式会社）所在地 
〒060-0041  

札幌市中央区大通東７丁目１２番地３３水野ビル 

TEL：011-251-4251（代表）、011-251-4381（システム部） 

FAX：011-251-4564 

http://www.nixus.jp 

Topaz Labs LLC 所在地 
5001 Spring Valley Road  

Suite 400 East  

Dallas, TX 75244  

Phone: 972.383.1588  

Fax: 866. 876.1393  

 

技術サポート 
NIXUS： 

http://www.club-nixus.jp 

support@hnikko.co.jp 

 

Topaz Labs LLCはダラス、テキサスの私企業で、高度な映像および画像補正技術の開発に取り組んでい

ます。今日広く使用されているデジタルスチルカメラや、デジタルビデオカメラ、HDTV などとともに、

高画質なデジタル画像および映像のニーズは非常に高まっています。Topaz Labs の使命は実験的な最先

端の画像・映像補正技術をプロや一般の顧客に提供することです。 
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Topaz製品ラインナップ  
 

画像プラグイン 

 

 

  

  

  

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

画像における露光、詳細、色彩

の総合的コントロールが写真

をポップに仕上げます。 

高度なノイズ軽減手法により

画像の細部を保持しつつ楽に

ノイズを取り除くことができ

ます。 

どんな写真でも美しい絵画の

ように仕上げることができま

す。 

はっきりとした画像を創りま

す。また、凹凸を平らにする効

果もあります。 
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映像プラグイン 

  

 

 

画像の鮮明度の向上、再構成、

引き伸ばし、高品質ノイズ除

去、JPEG圧縮補正における総

合的な画像補正ができます。 

高度な JPEG 圧縮アーティフ

ァクト除去フィルタにより画

像の詳細を保ちつつ JPEG 圧

縮アーティファクトを除去す

ることができます。 

容易に、効果的にビデオフレー

ムを捕らえ、画質と解像度を向

上させます。 

超解像技術を活用しながら最

適な映像補正フィルタにより

映像を向上させます。 


